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                                                                                1 How to create and personalize a PDF portfolio Creating and organizing a PDF portfolio is a simple process as simple as dragging and dropping files from one folder to another. To drag files into an empty PDF portfolio: 1. Start Adobe Acrobat 9 Professional. 2. Select File > Create PDF Portfolio. The portfolio work area appears (Figure 1). 3. Position the portfolio work area so you can see your desktop. From the desktop, drag documents or folders to the portfolio work area. The documents or folders you dragged appear in the portfolio work area (Figure 2). Figure 1 Portfolio work area Figure 2 Documents and folders in the portfolio work area As viewers drill down into the folder hierarchy, Acrobat automatically builds breadcrumb trails to help keep track of where they are in the PDF portfolio and help them find their way back up the folder hierarchy (Figure 3). Breadcrumb trail Figure 3 Breadcrumb trail You can also create folders inside the PDF portfolio, enabling you to organize (or reorganize) your documents even after they have been added to the PDF portfolio Adobe Systems Incorporated How to create and personalize a PDF portfolio 1
                                            










                                            2 To create a new folder in a PDF portfolio: 1. Open the portfolio. 2. From the Modify menu in the PDF Portfolio toolbar, choose Create New Folder (Figure 4). The New Folder dialog box appears (Figure 5). 3. Type a name for the new folder. 4. Click OK. The new folder appears in the portfolio work area. You can add files to the new folder by dragging them either from within the PDF portfolio or from the computer desktop. Figure 4 Modify menu in the PDF Portfolio toolbar Figure 5 New Folder dialog box Closing and opening the Edit Portfolio pane Once you have created a PDF portfolio, you can switch quickly in and out of editing mode. To open or close the Edit Portfolio pane: 1. Open the portfolio. 2. From the Modify menu in the PDF Portfolio toolbar, choose Edit Portfolio (Figure 6). The Edit Portfolio pane appears on the right side of the workspace. 3. If the Edit Portfolio pane is open, you can close it by choosing Close Edit Portfolio from the Modify menu. Keep in mind that anyone with Acrobat can edit any portfolio unless it has been secured with a password. For more about securing a PDF portfolio, see Securing the PDF portfolio. Figure 6 Modify menu in the PDF Portfolio toolbar 2 How to create and personalize a PDF portfolio 2008 Adobe Systems Incorporated
                                            

                                            3 Personalizing a PDF portfolio The robust PDF portfolio features in Acrobat make it easy to create a sophisticated presentation package. When users first open a PDF portfolio, they see the Edit PDF Portfolio pane on the right side of the portfolio work area. Every PDF portfolio can be viewed either in a customizable visual layout or in a list view. First, we will cover creating a visual layout. In the Edit PDF Portfolio pane, you can quickly customize the appearance of the portfolio. You can choose: A visual layout A welcome page A color scheme You can also specify the details to display about the contents of the portfolio. To choose a layout for a portfolio: 1. Open the portfolio. 2. In the Edit PDF Portfolio pane, open the Choose A Layout section (Figure 7). 3. Select one of the basic layout options: Basic Grid: Arrange files as thumbnails with text. On An Image: Arrange files on top of any image you want. Use the Pick An Image button to select the image to use as a background for your portfolio. Revolve: Bring one file into focus at a time. Sliding Row: Display several files in a row. Figure 7 Choose A Layout section 2008 Adobe Systems Incorporated How to create and personalize a PDF portfolio 3
                                            

                                            4 Creating a welcome page Portfolios posted to the web may be encountered by a variety of people. The welcome page provides context for the audience. It typically provides contact information and other useful details for the audience, such as instructions about what they can find in the portfolio and how to navigate it. To create a welcome page: 1. In the Edit PDF Portfolio pane, open the Add Welcome & Header section. The Add Welcome & Header section has two parts: the Welcome pane and the Header pane. Make sure the Welcome pane is open (Figure 8). 2. Select one of the options for the welcome page: No Welcome Page: Select this option if you don t want a welcome page or if you want to remove a welcome page you previously added to the portfolio. Text Only: Select this option for text. Acrobat provides a text area with text formatting options such as those found in a word processor. Image Only: Select this option to display a single image as your welcome page. Images can be JPG, GIF, or PNG formats. You can control the size and transparency of the image. Image & Text: Select this option to combine text and a single image. You can adjust the layout of the image and the text area. Flash Movie: Select this option to use a Flash movie as the welcome page. 3. If you selected text for your welcome page, click the text block and type the text you want displayed. Use the text options to format your text. 4. If you selected an image or a Flash movie for your welcome page, click the image object or the Flash movie object and select the file that contains the image or movie that should appear. Use the display options to modify how the object appears. Figure 8 Add Welcome & Header section Anyone who opens the PDF portfolio will first see the welcome page, with a Get Started button at the bottom. Viewers click the Get Started button to see the contents of the PDF portfolio. Creating headers A PDF portfolio header provides a consistent banner (and by extension, a persistent context) over the portfolio content. You can use the header to give your portfolio a name, offer contact information, or display images, such as a logo or photograph. Note: Acrobat also enables you to create headers and footers within a PDF document such headers appear on every page of the PDF they belong to. However, a portfolio header is different. The portfolio header is visible when viewers are navigating the portfolio but not when they have opened one of the documents the portfolio contains. 4 How to create and personalize a PDF portfolio 2008 Adobe Systems Incorporated
                                            

                                            5 To create a header: 1. In the Edit PDF Portfolio pane, open the Add Welcome & Header section. 2. In the Add Welcome & Header section, click Header to open the Header pane (Figure 9). 3. Select one of the options for the header: No Header: Select this option if you don t want a header or if you want to remove a header you previously added to the e-portfolio. Simple Text: Provides a text block you can format by using the text options. Structured Text: Provides several text blocks you can format by using the text options, including a text block you can use to provide a linked  address and another (labeled URL text) you can use to provide a linked web address. Logo & Text: Displays an image next to the text block in your header. Logo & Structured Text: Displays an image next to a structured text block in your header. Image Only: Displays an image in your header but no text. Text & Background Image: Displays an image behind the text in your header. 4. If you selected text for the header, click the text block and type the text you want displayed. Use the text options to format the text. 5. If you selected an image or a logo for the header, click the image object or the Flash movie object and select the file that contains the image or movie that should appear. Use the display options to modify how the object appears. Figure 9 Header pane The structured text option provides a text field for an  address and another for a web address (the URL text) (Figure 10). Acrobat automatically links the information in these fields so viewers can use them to create an  message. Figure 10 Structured text header 2008 Adobe Systems Incorporated How to create and personalize a PDF portfolio 5
                                            

                                            6 Adding headers or footers to documents Headers and footers present consistent information in the page margins throughout a PDF. The information could be the name of the project, a date, automatic page numbering, the title of the PDF document, or the name of the author. You can add headers and footers to one or more PDFs, including component PDFs in a portfolio. After applying a header and footer, you can edit, replace, or delete them in the PDF. You can also preview headers and footers before applying them and adjust the header and footer margins so they don t overlap other page content. 6 How to create and personalize a PDF portfolio 2008 Adobe Systems Incorporated
                                            

                                            7 To add headers or footers to multiple documents in a portfolio: 1. Open your PDF portfolio. Select the PDF documents in the portfolio for which you want to have headers or footers. To select multiple documents in a PDF portfolio, do one of the following: To select a range of documents, click the first document and then Shift-click the last document. All documents between the two are selected. To select individual noncontiguous documents, Ctrl-click (Windows) or Command-click (Mac OS) each document. To deselect an individual document, Ctrl-click (Windows) or Command-click (Mac OS) that document. 2. Choose Document > Header & Footer > Add. The Add Header And Footer dialog box appears (Figure 11). 3. As needed, specify the Font and Margin values. These text properties apply to all header and footer entries that are part of this setting definition. To apply different settings to different documents, open each document individually to add the header and footer, and follow steps 2 6. To prevent the new header or footer from overlapping with the content of the PDF document, click the Appearance Options button and select Shrink Document To Avoid Overwriting The Document s Text And Graphics. 4. Type the text in any of the header and footer text boxes. To insert page numbers, click the Insert Page Number button. To insert the current date, click the Insert Page Number button. You can combine text with dates and page numbers. You can also add several lines of text to an entry. 5. To specify the pages on which the header and footer appear, click the Page Range Options button. Then specify a page range and choose a Subset option as needed. 6. Examine the results in the Preview area, using the Preview Page option to see various pages of the PDF. 7. Click OK. To edit headers or footers, choose Document > Header & Footer > Update. Then make the appropriate edits. Figure 11 Add Header And Footer dialog box 2008 Adobe Systems Incorporated How to create and personalize a PDF portfolio 7
                                            

                                            8 To remove headers or footers: Do one of the following: Open a single PDF, or select one or more component PDFs in a portfolio. Then choose Document > Header & Footer > Remove. To remove headers and footers from multiple PDFs, close any open documents and portfolios. Then choose Document > Header & Footer > Remove. In the dialog box, click Add Files, choose Add Files or Add Open Files, and select the files. Click OK, and then in the Output Options dialog box, specify your folder and filename preferences. Selecting a color scheme PDF portfolios can be personalized by selecting a color scheme. Select one of the preconfigured color schemes provided in Acrobat or create your own customized color scheme. Consider visiting Adobe Kuler at   for additional help with selecting a color scheme. To select a preset color scheme: 1. In the Edit PDF Portfolio pane, open the Select A Color Scheme section. 2. In the Select A Color Scheme section, click one of the 16 preset color schemes (Figure 12). Your PDF portfolio color scheme changes to match the preset colors. Documents remain unaltered by changes to the portfolio color scheme. Preset color schemes Figure 12 Select A Color Scheme section 8 How to create and personalize a PDF portfolio 2008 Adobe Systems Incorporated
                                            

                                            9 To customize a color scheme: 1. In the Edit PDF Portfolio pane, open the Select A Color Scheme section. 2. In the Select A Color Scheme section, click Customize Color Scheme. The Customize Color Scheme pane appears (Figure 13). It contains a Lightness & Saturation control, a Hue slider, and five color categories. 3. Click one of the color categories. The categories are: Primary Text Color: The color used for the names of documents. This color should contrast sharply with both the card color and the secondary card color so document names are easy to read. Secondary Text Color: Used for document descriptions and when text is being selected. This color should also provide a comfortable reading contrast with both the card color and the secondary card color. Background Color: The primary color of the portfolio work area. Card Color: Cards are blocks that hold documents and folders. Card color refers to the color displayed on these cards when they are not selected. Secondary Card Color: The color displayed on cards when they are selected. 4. Drag the Hue slider to select a base color for the category. 5. Click or drag in the Lightness & Saturation control to choose a shade for the color. 6. Repeat steps 3 5 for all of the color categories you wish to change. Hue slider Lightness & Saturation control Figure 13 Customize Color Scheme pane 2008 Adobe Systems Incorporated How to create and personalize a PDF portfolio 9
                                            

                                            10 Using list view An alternative to a visual layout is list view (Figure 14). Acrobat automatically creates a list view for a PDF portfolio, showing a list of files by name, size, date the file was created and last modified, and any other details the portfolio author has added to the view. Also, you can add your own columns to list view. For instance, presenting a collection of work by various people involved in a project, you might add a column for authors names to identify which documents were created by each person. Figure 14 PDF portfolio in list view 10 How to create and personalize a PDF portfolio 2008 Adobe Systems Incorporated
                                            

                                            11 To add a column to list view: 1. In the Edit PDF Portfolio pane, open the Specify File Details section (Figure 15). 2. To add a column, click in the Add A Column text box and type a label for the column. 3. In the pop-up menu beside the text bpx, indicate the type of column you want (choices are Text, Number, Date). This choice determines the sorting rules for the column. 4. Click the + button to add the column to the list view. 5. In the list of columns to display, make sure the column is selected. You can remove columns from list view by deselecting them. You delete them permanently by using one of the following methods: Drag the column name to the trash icon at the bottom of the Columns To Display pane. Click the name of the column to select it. Then click the trash icon. 6. To add content to the new column, double-click the cell in the column for each item in the list, and type whatever you want displayed in the cell. Then press Enter (Windows) or Return (Mac OS). 7. If you want the new column to be the column by which the documents are sorted in list view, use the Initial Sort pop-up menu to select the column. Figure 15 Specify File Details section 2008 Adobe Systems Incorporated How to create and personalize a PDF portfolio 11
                                            

                                            12 Publishing a PDF portfolio Publishing a PDF portfolio is the simplest part of the process. Publishing is no more complicated than saving the document. You have multiple publishing options. The one you choose depends on how you plan to distribute the portfolio. You can: Save the portfolio (choose File > Save) and then copy it to a location where viewers can readily access it (say, a website). Send the portfolio via  . Share the portfolio on Acrobat.com (a free service that makes it easy to create, share, and collaborate with others on documents). To share a portfolio via   1. Open the PDF portfolio. 2. In the PDF Portfolio toolbar, choose  from the share menu (Figure 16). Acrobat uses your default  client to open a new  message with your PDF portfolio attached. 3. Complete the  message with a subject, a message, and the  addresses of those you wish to receive it. Then send the message. Share menu Figure 16 Share menu in the PDF Portfolio toolbar Navigating the PDF portfolio Anyone who opens the PDF portfolio can explore it by using either list view or the portfolio s visual layout. Viewers can use the PDF Portfolio toolbar (Figure 17) to switch between the two views. The PDF Portfolio toolbar consolidates all of the key ways to interact with a portfolio. Home Preview Save Share Modify List view Welcome Print Search Figure 17 PDF Portfolio toolbar Home: Navigate through files visually, using the layout you selected in the Edit PDF Portfolio pane. If you have opened a PDF document in the PDF portfolio, click this button to close the document preview and return to the portfolio. List view: Navigate through files by using file details. Preview: Preview the selected file. Welcome: Open the welcome page. Save: Save the portfolio as a whole or save the files individually. Print: Print some or all of the PDF files in the portfolio. Share: Share the portfolio with others, either by  or by posting the file to Acrobat.com. 12 How to create and personalize a PDF portfolio 2008 Adobe Systems Incorporated
                                            

                                            13 Modify: Edit the contents of the portfolio. From this menu, you can add files or folders, delete items, convert documents to PDF or Flash, compress the portfolio s file size, or secure the portfolio with a password. You can toggle the PDF portfolio editing mode. Securing the PDF portfolio If you want to be selective about who can view the content of the portfolio, it should be secured. You can secure a PDF portfolio by locking it with a password. Anyone who wants to view the contents must have the password to view it. To secure a portfolio with a password: 1. Open the PDF portfolio. 2. In the PDF Portfolio toolbar, choose Secure Portfolio from the Modify menu (Figure 18). The Document Properties dialog box appears, open to the Security tab. 3. In the Security Method pop-up menu, choose Password Security (Figure 19). Figure 18 Modify menu in the PDF Portfolio toolbar Figure 19 Security tab in the Document Properties dialog box 2008 Adobe Systems Incorporated How to create and personalize a PDF portfolio 13
                                            

                                            14 The Password Security Settings dialog box appears (Figure 20). 4. In the Compatibility pop-up menu, choose the version of Acrobat you want the security settings to accommodate (later versions provide more security). 5. In the Select Document Components To Encrypt section of the dialog box, select Encrypt All Document Contents. 6. Select Require A Password To Open The Document. 7. In the Document Open Password text field, type the password you want viewers to use to allow access. 8. If you want to control who can edit and print the document, select Restrict Editing And Printing Of The Document. When this option is selected, you can select more specific permissions with regard to printing, copying, and editing the contents of the portfolio. 9. Click OK. 10. If you changed the Document Open Password, the Confirm Document Open Password dialog box appears (Figure 21). Type the Document Open Password again, exactly as you did in the Password Security Settings dialog box. You may see a warning about the limitations of thirdparty software with regard to Acrobat security settings. If so, read the warning and click OK. 11. If you changed the Permissions Password, the Confirm Permissions Password dialog box appears. Type the Permissions Password again, exactly as you did in the Password Security Settings dialog box. Note: If you set a Document Open Password, the Permissions Password will also open the document and bypass the security settings. 12. A warning may appear indicating that security settings are not saved until the document is saved. If so, click OK. 13. Save the PDF portfolio to apply the security settings. Figure 20 Passport Security Settings dialog box Figure 21 Confirm Document Open Password dialog box 14 How to create and personalize a PDF portfolio 2008 Adobe Systems Incorporated
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        A Beginner s Guide to PowerPoint 2010 I. The Opening Screen You will see the default opening screen is actually composed of three parts: 1. The Slides/Outline tabs on the left which displays thumbnails    
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        Introduction to Microsoft Word 2003 Sabeera Kulkarni Information Technology Lab School of Information University of Texas at Austin Fall 2004 1. Objective This tutorial is designed for users who are new    
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        Adobe Captivate Tips for Success Before you begin editing your Captivate project, make sure you create a back up copy of your.cp file in case you delete something you need later. 1 Before You Record Your    
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        Contents 1. Introduction 1. Starting Publisher 2. Create a Poster Template 5. Aligning your images and text 7. Apply a background 12. Add text to your poster 14. Add pictures to your poster 17. Add graphs    
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        LESSON 15 Customizing forms and writing QuickBooks Letters 15 Lesson objectives, 398 Supporting materials, 398 Instructor preparation, 398 To start this lesson, 398 About QuickBooks forms, 399 Customizing    
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        PowerPoint: Design Themes and Slide Layouts Contents Design Themes... 1 Apply a theme to your presentation... 1 Theme colors... 1 Theme fonts... 3 Theme effects... 3 Quick Styles... 4 Customize a theme...    
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        COGNOS 8 Business Intelligence QUERY STUDIO USER GUIDE Query Studio is the reporting tool for creating simple queries and reports in Cognos 8, the Web-based reporting solution. In Query Studio, you can    
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        Adobe Reader Settings Table of Contents Adobe 9 and X (10) Reader Settings...2 For Adobe Reader X (10)... 5 Adobe Reader XI (11)...7 Internet Explorer 8 and 9... 8 Google Chrome... 9 Mozilla Firefox...    
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        Creating Forms With Adobe LiveCycle Designer 8.2 Instructional Media Center HCC Version 2 Modified Date 1/20/10 Learning Objectives: At the end of this training session the student will be able to use    
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        Hands-on Guide FileMaker Pro Using FileMaker Pro with Microsoft Office Table of Contents Introduction... 3 Before You Get Started... 4 Sharing Data between FileMaker Pro and Microsoft Excel... 5 Drag and    
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        ADOBE ACROBAT 7.0 CREATING FORMS ADOBE ACROBAT 7.0: CREATING FORMS ADOBE ACROBAT 7.0: CREATING FORMS...2 Getting Started...2 Creating the Adobe Form...3 To insert a Text Field...3 To insert a Check Box/Radio    
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        Oracle Business Intelligence Publisher: Create Reports and Data Models Part 1 - Layout Editor Pradeep Kumar Sharma Senior Principal Product Manager, Oracle Business Intelligence Kasturi Shekhar Director,    
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        KEYBOARD SHORTCUTS Instead of an SAP icon button, you can use a keyboard shortcut. A keyboard shortcut is a key or combination of keys that you can use to access icon button functions while you are working    
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        California State University, Fullerton Campus Information Technology Division Documentation and Training Services Handout Epson Brightlink Interactive Board and Pen Training Downloading Brightlink Drivers    
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        To Begin Customize Office Each of us needs to set up a work environment that is comfortable and meets our individual needs. As you work with Office 2007, you may choose to modify the options that are available.    
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        PowerPoint 2013: Basic Skills Information Technology September 1, 2014 1 P a g e Getting Started There are a variety of ways to start using PowerPoint software. You can click on a shortcut on your desktop    
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        Using Zimbra Briefcase The Zimbra Collaboration Suite has a built-in utility for storing and sharing files called Briefcase. Putting files into your Briefcase makes them available to you and others that    
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        Microsoft Word 2013 Tutorial GETTING STARTED Microsoft Word is one of the most popular word processing programs supported by both Mac and PC platforms. Microsoft Word can be used to create documents, brochures,    
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        Creating Hyperlinks & Buttons Adobe DPS, InDesign CS6 1 Creating Hyperlinks & Buttons InDesign CS6 Hyperlinks panel overview You can create hyperlinks so that when you export to Adobe PDF or SWF in InDesign,    
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        WORD PROCESSING In this session, we will explain some of the basics of word processing. The following are the outlines: 1. Start Microsoft Word 11. Edit the Document cut & move 2. Describe the Word Screen    
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        Getting Started Guide Mulberry Internet Email/Calendar Client Version 4.0 Cyrus Daboo Pittsburgh PA USA mailto:mulberry@mulberrymail.com http://www.mulberrymail.com/ Information in this document is subject    
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        You will be directed to the "Portfolio Settings! page. On this page you will fill out basic DIGICATION E-PORTFOLIO HELP GUIDE Where do I start? Log in to Digication Go to your school!s Digication login    
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        Using Microsoft Office 2003 Introduction to FrontPage Handout INFORMATION TECHNOLOGY SERVICES California State University, Los Angeles Version 1.0 Fall 2005 Contents Launching FrontPage... 3 Working with    
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        Alfresco Online Collaboration Tool USER MANUAL BECOMING FAMILIAR WITH THE USER INTERFACE... 4 MY DASHBOARD... 4 MY PROFILE... 6 VIEWING YOUR FULL PROFILE... 6 EDITING YOUR PROFILE... 7 CHANGING YOUR PASSWORD...    
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        How to create pop-up menus Pop-up menus are menus that are displayed in a browser when a site visitor moves the pointer over or clicks a trigger image. Items in a pop-up menu can have URL links attached    
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        Introduction To Microsoft Office PowerPoint 2007. Bob Booth July 2008 AP-PPT5 University of Sheffield Contents 1. INTRODUCTION... 3 2. GETTING STARTED... 4 2.1 STARTING POWERPOINT... 4 3. THE USER INTERFACE...    
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        Website: http://etc.usf.edu/te/ Google Docs is a free web-based office suite that allows you to store documents online so you can access them from any computer with an internet connection. With Google    
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        Email attachments You can send files, folders and other items within an email along with the mail message itself. Items which have been added to emails are called attachments. Adding an attachment to an    
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        C O D E : A E R O T E C H N O L O G I E S Password Memory 6 User s Guide 2007-2015 by code:aero technologies Phone: +1 (321) 285.7447 E-mail: info@codeaero.com Table of Contents Password Memory 6... 1    
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        TUTORIAL 4 Building a Navigation Bar with Fireworks This tutorial shows you how to build a Macromedia Fireworks MX 2004 navigation bar that you can use on multiple pages of your website. A navigation bar    
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        New Features in Microsoft Office 2007 TABLE OF CONTENTS The Microsoft Office Button... 2 The Quick Access Toolbar... 2 Adding buttons to the Quick Access Toolbar... 2 Removing buttons from the Quick Access    
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        There are three features that you should remember as you work within PowerPoint 2007: the Microsoft Office Button, the Quick Access Toolbar, and the Ribbon. The function of these features will be more    
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        Beginner s Guide to AIA Contract Documents Online Service for Single-Seat Users Table of Contents Getting Started - Introducing ACD5- AIA Contract Documents New Online Service System Requirements Transitioning    
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        In This Guide Microsoft Word 2010 looks very different, so we created this guide to help you minimize the learning curve. Read on to learn key parts of the new interface, discover free Word 2010 training,    
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        Timeless Time and Expense Version 3.0 Timeless Time and Expense All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic, electronic, or mechanical, including    
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        CHAPTER Working with SmartArt In this chapter by Geetesh Bajaj Understanding SmartArt 206 Adding SmartArt to a Presentation 206 Formatting SmartArt 208 Sample SmartArt Variants 211 Common SmartArt Procedures    
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        Accessible PDF Getting Started Types of Documents best suited for PDF on the Web Document is longer than 5 pages. You need to preserve the formatting or layout of the original document, e.g., for printing.    
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        Building a Personal Website (Adapted from the Building a Town Website Student Guide 2003 Macromedia, Inc.) In this project, you will learn the web publishing skills you need to: Plan a website Define a    
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        What Operating System (OS) do I have? Click once on the Apple apple menu in the upper left corner on your desktop Click on About this Mac - information is displayed such as the Processor speed and the    
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        Decision Support AITS University Administration Web Intelligence Rich Client 4.1 User Guide 2 P age Web Intelligence 4.1 User Guide Web Intelligence 4.1 User Guide Contents Getting Started in Web Intelligence    
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        FileMaker Pro 12 Tutorial 2007 2012 FileMaker, Inc. All Rights Reserved. FileMaker, Inc. 5201 Patrick Henry Drive Santa Clara, California 95054 FileMaker and Bento are trademarks of FileMaker, Inc. registered    
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        Lotus Notes Client Version 8.5 Reference Guide rev. 11/19/2009 1 Lotus Notes Client Version 8.5 Reference Guide Accessing the Lotus Notes Client From your desktop, double click the Lotus Notes icon. Logging    
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        Logi Ad Hoc Reporting System Administration Guide Version 11.2 Last Updated: March 2014 Page 2 Table of Contents INTRODUCTION... 4 Target Audience... 4 Application Architecture... 5 Document Overview...    
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        Creating Web Pages with Microsoft FrontPage 1. Page Properties 1.1 Basic page information Choose File Properties. Type the name of the Title of the page, for example Template. And then click OK. Short    
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        User Guide DYMO Label TM v.8 Copyright 2009 Sanford, L.P. All rights reserved. Revised 6/12/09. No part of this document or the software may be reproduced or transmitted in any form or by any means or    
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        Using the TI-Nspire Computer Link Software The TI-Nspire Computer Link Software lets you do the following: Transfer documents between your computer and a TI-Nspire handheld. Install a Chinese-English dictionary    
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        ADOBE CONNECT 8 USER GUIDE Colorado Department of Labor & Employment Enter a Meeting Room Getting Started - Enter a Meeting Room DO ONE OF THE FOLLOWING: 1. From the Home Page in Adobe Connect Central,    
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        MicroStrategy Desktop Quick Start Guide MicroStrategy Desktop is designed to enable business professionals like you to explore data, simply and without needing direct support from IT. 1 Import data from    
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        PLANNING FOR A SECURE RETIREMENT ADMINISTRATIVE VIEW User Guide: D2.6.39 Agriculture Information Technology Released: August, 2005 Revised: January, 2006 Version: 1.0 PLANNING FOR A SECURE RETIREMENT ADMINISTRATIVE    
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        ithenticate User Manual Version: 2.0.8 Updated February 4, 2014 Contents Introduction 4 New Users 4 Logging In 4 Resetting Your Password 5 Changing Your Password or Username 6 The ithenticate Account Homepage    
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        WOWS of Word Office brings a whole new basket of bells and whistles for our enjoyment. The whistles turn to wows. gfruth@wm.edu Templates Click on the Office Button PDF and select New. You can now change    
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        Web Intelligence User Guide Office of Financial Management - Enterprise Reporting Services 4/11/2011 Table of Contents Chapter 1 - Overview... 1 Purpose... 1 Chapter 2 Logon Procedure... 3 Web Intelligence    
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        Guide to PDF Publishing Alibre Design 9.2 Copyrights Information in this document is subject to change without notice. The software described in this document is furnished under a license agreement or    
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        User Guide for TASKE Desktop For Avaya Aura Communication Manager with Aura Application Enablement Services Version: 8.9 Date: 2013-03 This document is provided to you for informational purposes only.    

    
        More information 
    




    
        Flash Objects. Dynamic Content 1
    

    
        
        Dynamic Content 1 The WebPlus Gallery tab provides a wide range of predesigned Flash banners that you can add to your site, and customize to suit your needs. In addition, it s very easy to add your own    
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        Microsoft Office 2010 Tutorial Contents Microsoft Office 2010 Tutorial... 1 Find your way through long documents with the new Document Navigation pane and Search... 4 Adjust the spaces between lines or    
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        Microsoft Word 2011: Create a Table of Contents Creating a Table of Contents for a document can be updated quickly any time you need to add or remove details for it will update page numbers for you. A    
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        Student Portfolios Department of Geological Sciences Brigham Young University This document contains information on student portfolio requirements, formatting portfolios, and how to create a portfolio    
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